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Introduction to
POEM COMPU-STITCHTM

What is POEM COMPU-STITCHTM

POEM COMPU-STITCHTM is a simple to use, graphic based computer software
package, designed to allow hand embroiderers, sewing enthusiasts and hobbyists
of all walks to create machine stitched embroidery using a home computer and
the AISIN POEM embroidery machine.

This manual will guide you, step by step, through the operation of the software
and introduce you to the art and joys of computerized embroidery. Whether
you choose to edit and stitch out stock designs or take the plunge and create
your own embroidery designs from scratch, you will experience much pleasure
in the final stitched embroidery

1



POEM COMPU-STITCHTMI and POEM COMPU-STITCHTM II

cs_I

POEM COMPU-STITCHTMI(CS-I) software allows users of AISIN POEM
embroidery machines to:

• run the software on a suitably configured PC compatible computer

• stitch POEM format designs on a POEM embroidery machine

• create new automatic lettering for POEM machines in 3 letter styles,

block, serif and script alphabet
and vary letter height from 5mm to 50mm

• combine automatic lettering with new or existing POEM designs

• display POEM designs on the screen in actual size or with pan and zoom

• automatically centre the design for stitching

• set thread colours for display

• control machine functions such as make jump, colour change, set applique

• perform basic editing of designs or portions of designs

cut, copy, paste
delete
move, rotate, mirror image

• scale designs to different sizes (within practical limitations)

• save designs in POEM format on hard disk or floppy disk

• print designs by “print screen” to printers.

cs_li

POEM CQMPU-STITCHTMII(CS-Il) software allows users of AISIN POEM
embroidery machines to:

• take advantage of all CS-I features

• create their own unique designs by,

using a pixel image from a third party scanning/drawing program
as a guide or template

positioning stitch points around an on-screen template with a
mouse.

choosing where and when each stitch type is to be used within a
design. The three stitch types available are,

manual stitch
satin stitch - automatic parallel or turning calculation
fill stitch - automatic parallel calculation

I
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POEM COMPU-DES1GNSTM

POEM COMPl.J-DESIGNST1are sets of embroidery designs covering vanous
themes. They have been specifically designed for use with your POEM COMPL
STITCHTM System. Just load the additional software designs from the COMPU
DESIGNSTM disk onto your computer and you are ready to stitch. Some
standard design sets

Sports I

Sports II

Sports Mascots

Scary Things

Kids I
Kids II
Animals,

are available on disk for purchase. Contact your nearest POEM COMPU
STITCHTM dealer for more details.

Chapter 1 - Introduction to POEM COMPU-STITCH1 3
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Install POEM COMPU-STITCHTM

Before you can use POEM COMPU-STITCHTM,you must install the software on
your computer and connect the POEM machine.

o Make backup copies of POEM COMPU-STITCHTM

Connect the POEM embroidery machine

€ Connect the MemoPlug (CS-Il only)

o Install POEM COMPU-STITCHTM onto your hard disk

You will need:

— I POEM sewing machine, connecting cable and transformer.
— 1 MemoPlug (CS-Il only).
- 3 POEM COMPU-STITCHTM disks.
— 3 Blank, 3.5” High Density disks.

POEM COMPU-STITCHTM requires a 386 or 486 AT compatible computer with a
minimum of 4 Mb RAM, a 40Mb hard disk, a VGA colour monitor, a mouse,
and DOS 5 to run. While a floating co-processor is not an absolute requirement,
POEM COMPU-STITCHTM will work faster if one is installed.

These instructions assume that you are familiar with DOS terms and basic
operations. If not, consult your computer’s reference manual.



Backing up the Original POEM COMPU-STITCHTMDisks

IMPORTANT : The original POEM COMPU-STITCHTM disks are High Density
(HD). When making backup copies you must use High Density disks.

I>
backup

procedure

NOTE: If your 3.5” drive is the B:

diskcopy a: a: EJ

drive use the command diskcopy b: b:

I

You may be asked to swap the disks in and out of the drive
a few more times before the diskcopy is completed.

n:=
iEnter —

if diskcopy
is complete

[

[

+
original disks original disks backup copies

Store the disks
in a safe place.

Use the backups for the
installation then store
them in a safe place.

Do not store both sets in the same place!

Insert SOURCE disk in drive A:

Press any key when ready

Insert TARGET disk in drive A:

Press any key when ready

insert
original disk

-

-

[
[

I

I

insert
backup disk

remove
original disk

Enter +—

Copy another disk? (YIN)

6 Chapter 2 - Install POEM COMP U-STITCHTM



Connecting the POEM machine

Connectors and Cab’es

At the rear of your computer are a number of connectors, known as ports (See
diagram). The two ports you will use are COM1 (serial) and LPTI (parallel). Note
that this diagram shows a typical port set-up. The actual port set-up on your
computer may be different.

COMI (Serial)

LTP (parallel / printer)

The cable connecting POEM to your computer has two distinct ends. The small
end is an 8 pin, male DIN connector, and connects to the POEM machine. The
larger end is a female 9 pin connector, and connects to the COMI port on your
computer.

9 pin female (to computer)

Connection Diagram

8 pin DIN male (to POEM)

Chapter 2 - Install POEM COMP U-STITCHTM 7



Connecting POEM to your Computer

Note: Before you begin turn your computer OFF

o Connect the small end of the
cable to the POEM port
marked LINE.

€3 Connect the large end of the
cable to the COMI port at the
rear of the computer.

€3 Connect the transformer to
the POEM port marked DC
12V.

Make sure that POEM is OFF
(power switch is on 0).

o Connect the transformer to a
power outlet.

—

rLJ/a En
L_rJ

I

I
1
I
I

[

Connecting MemoPlug (CS-li only)

[
[

NOTE: CS-Il software will not
run without MemoPlug
attached. If MemoPlug is not
attached, only CS-I features will
be available.

Connect MemoPlug to the LPTI
(printer) port.

If you have a printer connected
to this port, disconnect the
printer, connect the MemoPlug,
then reconnect the printer to the
rear of the MemoPlug.

_

--

. .0,

LJ’Tl Memo Plug Printer

[
[
I
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Installing the POEM COMPU-STITCHTMSoftware

— you have backed up the original POEM COMPU-STITCHTM disks,

— you have copies of all (3) POEM COMPU-ST1TCHTMdisks,
— you have installed DOS 5 on your computer,
— the POEM machine is OFF.

Insert the installation Disk #1 in drive A: (or B:)

[C:\>

Cs Software Installation

Checking PC system...
Installing CS Program files...

Configuring operating system settings...

Insert
Disk #1

a:install

The installation program will automatically place the system under the
directory C:\CS. Any sample designs installed by the system will be placed in
the directory C:\POEM.

Please load Disk #2
Press <Enter> when ready...

nstalling Disk #2 software files...

Remove
Disk #1

,J1Enier

Insert
Disk #2

Before beginning this procedure, make sure that:

9 Chapter 2 - Install POEM COMP U-STITCHTM



Remove
Disk #2

Ener.—3

Insert
Disk #3

0

(:

Remove
Disk #3 I

I

I

I

I

I

I

F

F

F

F

F

Please load Disk #3
Press <Enter> when ready...

The system will now reboot.
Please remove the floppy disk from the drive.
Press <Enter> when ready

10 Chapter 2 - Install POEM COMP U-STITCHTM



Start the POEM COMPU-STITCHTM Software

Before attempting to start the software, make sure that:

— the POEM machine is switched on
— the DOS prompt is on screen (if not exit to DOS)

We recommend that you make a habit of starting POEM COMPU-STITCHTM
from the POEM directory. This directory stores any sample designs available for
use in POEM COMPU.-STITCHTM.It is also the directory where POEM COMPt.J
DESIGNSTM are automatically placed duhng installation.

(PoEM> Cs
nte7]

To start the software

POEM Copu—Stitch I for PC

Ui .

19:4:53 Har 2 1993

Cc) Copyright Aisin World Corp. of Rrerica 1993

ll rights reserved

Portions of this product are protected by the following patents:

USR: 4.821.62 Europe: EPZ211G3

Other patents pending

Ox I
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Up-dating an Existing POEM COMPU-ST[TCHTM I
You can install new versions of POEM COMPL-STITCHTM as updates over the
top of your existing system. If you install a new version of POEM COMPU

STITCHTM in the CS directory, the old system files will be overwritten. If you
wish to keep the old system, install the new version in another directory, for
example, CSNEW.

Note: your embroidery designs can not be overwritten by this process because
they are stored in a different directory (\POEM) to the system files. I

Insert the installation Disk #1 in dnve A (or B)
I

Insert
Disk #1

1 a:instali I

CS Sofare installation 1 1
ChecKng PC system

(Files found in directory C:\CS
14.9verwrite C:\ Cs? [YJ:

______

j

[Deietgoidfiles... 3 1
nstailing CS Program files... IConfigunng operating system settings... J

I

I
Continue as described in Installing the POEM COMPU-ST1TCHTM Software.

I

I
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Installing POEM COMPU-DESIGNS

Before beginning this procedure, make sure that:
— you have backed up the original POEM COMPU-DESIGNSTMdisks,

— the POEM machine is OFF.

Insert the POEM COMPU-DESIGNS Disk in drive A: (or B:)

Insert Disk

[C:\>

[Installing Compu-Designs files...

a:install

A sub-directory for the new designs is created under the C:\POEM directory
automatically. The name of the new sub-directory will correspond to theme

name on the POEM COMPU-DESIGNSTM disk.

Remove
Disk

Enter—1

Installation complete.
Please remove the floppy disk from the drive.
Press <Enter> when ready

Chapter 2 - Install POEM COMP U-STITCHTM 13



Troubleshooting

Below is a table listing possible
overcome them.

I
Installation

causes of installation errors and how to

Error Action
Not enough disk space. Check available disk space.

CS-I/Il needs a total of 8 At the prompt type dir” then press
Megabytes of hard disk space to <ENTER>.
function: Check available disk space.

4 Megabytes to install Delete unnecessary files to create 8 Mbytes or
4 Megabytes to run more of hard disk space.

8 Megabytes Total

Not enough memory. Check available memory.

CS-I/Il requires 4 Mbytes of Reboot the PC.
RAM to run. Check that 4 Mbytes or more is checked

correctly. Contact your supplier if not.

DOS 5 not installed. Check which version of DOS is installed.

CS-I/Il requires DOS 5 or later To see which version of DOS is installed,
to run. type ‘ver’ at the DOS prompt then press

<ENTER>.
If an earlier version is displayed, (eg DOS
3.1), install DOS 5.
See the DOS Users Manual for installation
instructions. Install CS-I/Il Software again.

Unable to find the Mouse Locate mouse driver on computer, or
driver.... (mouse.sys) Stop CS-I/li installation and install a mouse

Which directory is it in? and driver.

(C:\DOS)

CS-I/Il uses a mouse. It works If you know, enter the directory where the
with a bus mouse, a serial mouse mouse.sys file is. The default is C:\DOS.
or an on-board mouse (PS/2), and If you do not know or do not have a mouse
uses the standard mouse driver connected to your system, you must stop the
software distributed with the CS-I/Il installation process.
mouse. If during installation CS- Press <Ctl> and <C> at the same time, to
I/Il cannot find a mouse driver, exit the installation.
the question above will be asked. Turn your computer off.

Connect an appropriate mouse for your
computer.
Turn the computer on.
Install the mouse driver software.
(See the mouse and mouse driver installation
manual for instructions.)
Install CS-I/Il.

I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

I
14 Chapter 2 - Install POEM COMP U-STITCHTM



Start the Program

At some time, you may have problems starting your software. Don’t panic. You
haven’t broken it. There are certain conditions under which POEM COMPU
STITCHTM will not operate. Take a little time to double check the computer and

POEM machine setup and you will solve most problems quickly.

Problem

CS-I/Il won ‘t start.

Action

Check POEM is connected to
computer.

The POEM machine must be
connected to the computer before

POEM COMPU-STITCHTM will
operate.

the

Are the connecting cables firmly in place?
Is the transformer connected to the POEM
Is the transformer plugged in and on?
Is the red light on top of the POEM on?
Is the POEM plugged in and turned on?
Is the POEM connected to the computer?
(Refer to A Note About Connectors And
Cables and Connecting POEM To Your
Computer for details)

POEM COMPU
TM

STITCH runs but CS-I
appears in the title bar
instead of CS-Il.

Check that you have the MemoPlug.

CS-Il requires a MemoPlug to
operate. It is supplied with the
program at the time of purchase.
If the MemoPlug is not attached
to the computer the program will
run but only the features of CS-I
will be available.

Is it attached to the LPT1 (printer) port on
your computer?
Is the connection firmly in place?
(See Connecting POEM to your computer for
details)

Chapter 2 - Install POEM COMPU-STITCHT1 15
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3
Sew Existing Designs

Now we are ready to start working with POEM COMPUSTITCHTM. First we
will see how to sew out a simple design such as you could easily produce for
yourself if you have CS-Il. A sample design has been included and we will show
you how to sew it.

Start the System

To enter POEM COMPUSTITCHTM you simply:

o turn on your PC

@ turn on your POEM machine

€ go to the POEM directory by entering cd\POEM

0 type cs then press <ENTER>.

A message will be presented, see over.

17
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Clear this message by moving the arrow shaped pointer - move the mouse -

until it points to the box marked “OK”. The shape of the pointer will change to a
hand. Then click the button. Alternatively you can press the <ENTER> key.
The next message will be presented.

POB Go,ipu-Stitcb for PC

Fox- an up to date list of Conpu-Designs
please contact your local dealer

Chapter 3 - Change Individual Stitches
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POEM CorpuStltch I for PC
VI. BA

19:40:53 Mar 2 1993
Cc) Copyright Aisin World Corp. of Arerica 1993

nil rights reserved

Portions of this product are protected b the following patents:
USA: 4.8Z1.62 Europe: EP0221163

Other patents pending

F ox

4any standard designs are available For your POEM Conpu-Stitch Systen

Anjnajs, Birds, Children, Sports. Festive. etc.

Ox I

Click on “OK” again then the POEM CS window will be presented.
I’OEN CS-I Ih,tltled Scale 1.I

I
I
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Open an Existing Design

Using the Menus

The software is operated by giving it commands from lists called menus. To
view a menu move the pointer to the menu name listed across the top of the
screen — the menu bar. To open a design move to the File menu. Again the
pointer will change to a hand. Click on the box named File.

A list of commands will drop down below the menu bar. Move the pointer over
“Open...”. The command will be highlighted.

A dialog box is presented that lists files in the current directory that contain
designs. Across the top are boxes that allow you to choose the location of the
files you want to see listed. The design we are going to sew -BALLOONS.CSD- is
listed below.

Displaying the Design

To display BALLOONS.CSD click on the name on the list. The file listing will be
highlighted to show that it has been selected. Click on “OK”

Note that you cannot display a design by double clicking on the file.

Check the Frame

Now our design is displayed on the screen. The number of stitches in the design
is shown in the bottom left hand corner of the screen.

You can investigate the design now it is displayed on the screen.

Show Au

To see the design in the largest size that will still allow it to fit on the screen
choose “Show All” from the Display menu. The scale will be shown in the top
right hand corner of the screen.

Chapter 3 - Change individual Stitches 19



1:1

To return your design to actual size click on 1:1 in the display menu. The design
is displayed the same size as the finished embroidery.

Disp’ay the Frame

Sew the Design

Choose “Large Frame” from the Display menu. A representation of the frame
will be displayed on the screen. The menu item will be ticked to indicate that
the frame is displayed.

Notice that the design fits within the sewing boundary which is shown as a
dotted line.

I
I
I
I
L
[

You are now ready to sew the design. Choose Sew from the File menu.

There will be a short delay then the Sewing Controls dialog box will be
presented. This dialog box shows instructions, the colour used in the screen
display for the currently sewing thread, the stitch number that the machine has
reached and a number of buttons to control the machine.

The instructions box inside the Sewing Controls dialog box gives instructions
and error messages as you sew.

Prepare for Sewing

You have displayed a representation of the frame on the screen. Now you need
to prepare the actual frame filled with fabric. Select the same frame as you have
displayed, in this case the large frame.

Use a firm, woven fabric such as linen. See Sewing on Different Fabrics at the
end of this chapter for details of handling other fabrics.

Fit the fabric into the frame. The frame is used the same way as a hand
embroidery frame. The fabric should be stretched tightly across the bottom of the
frame. Tighten the screw so that the fabric is drum tight. The two parts of the

L

E
[
[
[
[
[
L

Sewing Controls

ad thread for colour 1 T
ess Start to begin sewing.

Colour 1:

L Backup j Stop [ Start

Stitch:

Pull Up

Cancel
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frame should fit together neatly. Don’t let the inner hoop of the frame sit above

or below the outer hoop as this will interfere with sewing.

The dialog box which is displayed shows the colour used in the screen display
for the first thread and the instruction “Load thread for colour 1”. Thread the
machine as described in the POEM-500 Hardware Users Manual.

Check that you have sufficient bobbin thread to sew the design.

Attach the frame to the machine

Start Sewing

Click on the “Pull Up” button. This causes the machine to pull up the bobbin
thread.

Click on the “Start” button.

The machine sews a few stitches then stops. This is so that you can trim the
excess thread. You will see that the instruction box contains a message to that
effect.

Click on the “Start” button again.

The machine will sew colour 1.

When the machine reaches a colour change it stops again so that you can
rethread the machine. The dialog box shows colour 2 this time for the first
balloon coloured blue on the screen.

When you are ready click on “Start” again.

Other Actions

You can press “Stop” while sewing to stop the machine.

While stopped you can press “Back Up” to make the machine move back a
stitch. The instruction box will show “Backed up X stitches”. You can back up as
many stitches as you like. When you press Start again the machine will start
sewing from the new position. This is useful if the thread breaks.

You can stop and remove the frame from the machine at any time. Replace the
frame when you are ready to recommence sewing.

If you want to stop sewing entirely and return to working on the computer you
can click on “Cancel” at any time.

Finish Sewing

Continue sewing as above until the design is finished. You can tell how far you
are through the design by comparing the number of stitches shown in the dialog
box with the number of stitches in the design.

When the whole design has been stitched the instruction box will show. “The
design is finished. Press ‘Cancel’ to exit.”

Press “Cancel” and the dialog box will be removed from the screen.

Chapter 3 - Change Individual Stitches 21



Use POEM COMPU-DESIGNSTM

Your sample design BALLOONS.CSD is stored in the POEM directory. When
you load POEM COMPUDESIGNJSTM they are usually stored in sub-directories.
The name of the sub-directory is the same as the name of the theme the designs
belong to. [
When you choose “Open’ and display the dialog box the files listed are those in
the directory shown in the box beside “Dir”. At present that is the POEM
directory but to list your POEM COMPU-DESIGNSTM you will need to change it
to the appropriate sub-directory.

Click on the arrow on the side of the Dir box. A drop down list of directories will rbe displayed. The name of the directory you are in will be shown with dotted
lines above and below it. Above the upper dotted line are the parent directories
at present C:\. Below the lower dotted line the subdirectories are listed. Click on [the sub-directory you want. The design files in that sub-directory will be listed.

When you want to use a different sub-directory click on the Dir box and select
the POEM directory. When you are back in the POEM directory select a new
sub-directory.

Disk IC:DOS L!J Dir POEM !1 Files .CSD
C:\CS\POEM No files selected 5345280 bjtes free

File,,ap,e File Size Date Tine

BALLL3ONS.CSD 102 09-Har-93 14:S:40

OX j jaiT1

Scroll the Files List

There may be more files in the directory than can be displayed in the Open
dialog box. At the right of the files list is a “scroll bar”. You can use this to view
details of files below the last file on the list. At the top and bottom of the scroll
bar are boxes with arrows on them. Place the pointer on the box with the down
arrow and press the mouse button and keep it down. The list of files will scroll
upward adding new files to the bottom of the list. Use the box with the up arrow
to show the top of the list again.

Chapter 3 - Change Individual Stitches
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The bar at the side of the files list also contains a white box. This box indicates
where the group of files you have displayed are in the full ist represented by te
bar. You can also scroll the files list by moving the box. Place the pointer on the
box, press down the mouse button and move the mouse.

If you prefer you can copy your POEM COMPU-DESIGNSTM into the POEM
directory. lse DOS command to cops’ from your floppy disk.

Listing Files on Different Disks

The first box in the Open dialog box is labelled “Disk”. This box shows the hard
disk C: DOS and the contents of the hard disk are listed below. If you want to list
the files on a floppy disk click on the arrow on the right of the box. A drop down
list of disks will be presented. When you want to change the disk click with the
pointer on the one you want e.g. B:DOS for a disk in the B: drive. At the
moment we want to sew designs from the hard disk so we will leave this box
showing C:DOS.

Sewing on Different Fabrics

Backing

Embroidery needs a firm foundation so firm fabrics are best to sew on. To assist
with this a firm non-woven backing can be used with other fabrics. This is
especially important with light or stretchy, knitted fabrics such as used in
T-shirts. The backing can be trimmed after you have sewn your embroider!.

Sewing in Different Colours

You do not need to stitch your designs in the same colours as the screen display.
You will need to know when to use each colour because the dialog box will
show the screen display colours. Make a list of the screen colours with the
corresponding thread colours that you want to use instead. Then when the
dialog box shows the screen display colour you will know what thread colour to
use.

Chapter 3 - Change Individual Stitches
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4

Create Lettering

To give a touch of elegance to lingerie, table linen etc. you can easily create
designs consisting of lettering or add lettering to existing designs. Lettering can
be varied from the plain and functional to beautiful, flowing script. Three
different styles of alphabet are available (see illustrations in the Appendix) in
sizes from 5mm to 50mm. The alphabets can be varied by adjusting the width or
the slant of the letters.

Start a New Design

EN

Choose “New” from the File menu. This will close the currently open design
and replace it with an empty design. The top of the screen will show “Untitled”.

If you have just turned the system on an untitled design will already be
displayed.

Display the Frame
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Enter Letters

Before inputting your lettering you need to decide on the satin stitch spacing.
Choose ‘Satin Values” from the Fills menu. A default value will be displayed.
This value will be suitable for most purposes but you can change it if you wish.

Smaller stitch spacing is suitable with fabrics like towelling and for longer stitch
lengths used in large lettering as it covers better. Wider spacing is suitable for
short stitch lengths used in small lettering.

Click on “OK” when you are satisfied with the values.

This step can be skipped if you do not want to change the spacing.

1

I

1

I

I

o Choose “Lettering from the Fills menu.

A dialog box will be presented in which you can define the lettering

@ Type in the letters you want to embroider.

Enter one line of up to 40 characters

To type in characters place the pointer over the box and it will change to an
I-beam. Click with the left mouse button and it will change to a vertical line
indicating that you can type in an entry. Use the <BACKSPACE> key to
delete characters.

[

r

I

F

F

I

Set Satin Values

I

LetteTinq

Letters

Height

Width

SI ant

12.S Jrii.i

lea

I Iiideg

I ox

Alphabet FcRIPT L!1

Spaci.g

CanceI
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€ Specify Letter Height.

The size of the lettering is determined by specifying the size of a capital letter
in the alphabet.

Enter the height you want the letters to be from 5mm to 50mm.

You can change the value shown in two ways. You can click on the up and
down arrows to increase or decrease the value shown. You can also type in
the value you want to set.

John Warner
CAPTAIN
The height of the capital letter affects

the total width of a monogram.

John Warner
CAPTAIN

Reduce the height of the capital letter and
the width of the monogram decreases.

0 Specify Letter Width.

The standard width of letters depends on the shape of the letters and the
selected letter height. You can adjust the width of the letters to a percentage
of the original. How effective this is will depend on the letters and the
alphabet used. You will be able to judge by looking at the screen display of
the planned stitching. Too large a change will result in excessive distortion
of the shapes of the letters. In most cases a changeof up to ± 20% would be
the maximum likely to give a satisfactory result.
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I
Monogram is too wide for the stitching area.

Enter 80% in the width box.

I

(

JWrn

Monogram width has changed but the letter height j
remains the same

I
Specify Slant Angle.

You can adjust the letters to be slanted from -30 to +30 degrees. Enter the

angle in degrees. It is recommended that you do not slant the Script

alphabet.

I

I’
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Choose an Alphabet.

Click on the arrow to display the drop-down list then click on an option. Th

alphabets available are:

Block
Serif
Script

See the Appendix for an illustration of the alphabets.

€1 Specify Letter Spacing.

For the Script alphabet you should use a spacing of zero.

For Block and Serif alphabets enter the spacing between letters in mm. The

recommended value is one tenth the letter height.

0 Click OK if all items are correct.

Click on “OK” at the bottom of the Lettering dialog box when you are happy

with your entries. If you decide not to proceed, click on “Cancel”.

The screen will go black and display the message “Please wait” while the

stitches are calculated. Then the usual screen will be redrawn.

The calculated lettering will be displayed in the centre of the frame.

€ Check Frame

Check that the lettering fits within the frame. The dotted line indicates the
borders of the stitching area.

If you need you can move the frame. Click inside the frame. A rectangle will

be displayed to indicate the new frame position. Move the rectangle to
where you want to place the frame then click again.

Select Auto Centre from the Fills menu

Ensure that stitching starts and finishes at the centre of the frame. Stitches

will be inserted from the centre to the starting point of the lettering and

from the end of the lettering to the centre.

If you are dissatisfied with the result and wish to start again select “New” and
start again. If you want to scrap your work and finish working in CS select
“Exit”. When you make these selections a message will appear to check that you
do not want to save your work (see below). Click on the “No” button.

If you are happy with the result you can sew it as described in chapter 3.
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Save Your Design
[

You can save a permanent copy of your lettering design if ‘ou intend to sew it [
again.

Choose Sove from the File menu.

The first time you save a new design a dialog box will be presented that asks you

for the filename

Type in the unique filename you want to give your design (see chapter 9).

If you continue working to amend your design you should save every five [
minutes. When you save the design the second time no dialog box will be

presented. The design will be saved under the specified name.

How to Create Multiple Lines

r
r
I

0 Create the first line of lettering using steps one to eight.

@ Check Frame.

You may want to position the first line of lettering at the top of the frame to

ensure that you have plenty of space for the later lines. Choose Large Frame

or Small Frame from the Display menu. Move the representation of the

frame. Leave the frame displayed to help with positioning the next lines of

stitching.

€3 Create the second line of lettering. [
This time you will want to position the lettering so that it fits in the frame

and is in the desired position relative to the other lettering.

An extents box i.e. a box the sides of which are at the outer extents of the

stitches will be displayed on your screen to indicate the stitches. This box is

ready for moving to position the lettering .

O Position the second line of lettering.

The prompt line shows “Pick guide point”. Click with the pointer in a

position relative to the extents box that will enable you to reposition the

stitches correctly e.g. a distinctive point.
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The prompt line shows “Place selection”. Drag the mouse and the extents box

will move with the pointer staging in the same relative position. When the

pointer and the extents box are indicating the position where you want the

lettering to be, click on the mouse. The extents box will disappear and a

representation of the stitches will be displayed.

This should result in the arrangement you want; however, if you are not

satisfied with the result don’t despair the stitching can still be moved. See

description of “Move” in chapter 7.

You can add further lines of stitching if you wish and if they will fit in your

frame.

O Choose Auto Centre from the Fills menu.

If you do not centre the design it will be done automatically when you sew.

Sew

After you have sewn the embroidery you can trim the threads joining the

lines of lettering.
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Add Lettering to Existing Designs

I

Existing designs can be individualized by the addition of captions. rnottos etc

o Open the design. 1
9 Input lettering.

9 Position lettering.

o Save the new design under a new name.

You may want to save the new design with lettering as well as keep the
original design. If you choose “Save’, you will save the new design in place
of the old design under the original filename.

To keep the original file as last saved and save a copy of the new combined
design choose “Save As” from the File menu. A dialog box which allows
‘iou to enter a new filename is presented.

The new design will be saved under the new filename and the original
design will be kept in the form it was in when you last saved it, under its
original filename and in the original disk and directory. I

@ Sew

You can sew the design after you “Save As”. Once the design is saved you I
can open it at any time and sew it. Trim the thread between the design and
the lettering.

The lettering will be added to the end of the design and will be sewn in the
same colour thread as the last colour in the design. To stop the machine to
change the thread before you sew the lettering see Add Colour Change in [chapter 6.

I
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5

Sew Designs in Different Sizes

You can change the size of your design so that it fits on a garment or so that you

can use it for different applications.

0 Display the frame

@ Select all the stitches of the design.

The first thing you have to do is let the computer know that you will be

working with the design. This is known as “selecting” a part of the design.

Selecting is a basic process used with many commands.

To select the whole design for scaling choose “Select All” from the Modify

menu. The stitches will all be displayed in black to show they have been

selected for action. If you decide not to proceed you can deselect the stitches —

return them to normal — by choosing “Deselect All”.

€3 Choose “Scale” from the Modify menu.

An extents box is displayed around the design. You will change the size of

the extents box to indicate the way you want the design resized. The prompt

line will show the scale.

o Pick anchor point.

The prompt line shows “Pick anchor point”. The anchor point will stay in

the same position. Click on an appropriate point to help you resize the

design. See the diagrams below to see how the anchor point and guide point

operate.
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anchor point

anchor point

[

[

i•r
anchor point

The prompt line next shows “Scale selection”. Move the mouse and the

extents box will change size. The prompt line shows “Scale xx.xx”.

Click when the box is the desired size. The stitching will be displayed at the

new size.

Save your new version of the design. You will probably want to Save As

under a new filename so that you keep your original design and have your

new version as well.

[

ollit

gUaeV

Pick guide point.

The prompt line next shows “Pick guide point”. Click on a second point to

use to change the size of the extents box for scaling.

Resize the design.

€1 Save the design under a new name.

£
[
[

r
I

r
I
t
(
[

[

Sew the design.

You can sew the embroidery from the design any time you like as described

in chapter 3.
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Undo

If you are unhappy with the result or change your mind about the resizing
when you see the displayed stitches, you can reverse the scaling. Choose “Undo
from the Edit menu.

You can “undo” several processes. Most transformations of the design
(described in later chapters) can be undone if you are not satisfied with the result
or otherwise change your mind.

Undo is a toggle command which means that ‘ou can switch between the before
and after states. If you choose undo the design will revert to its original state
then if you choose undo again it will return to its new state.

Tips and Limitations on Scaling Designs

To achieve the best results you need to have some understanding of the resizing
process. Your design is made up of stitches which have been planned with a
particular size of result intended. There are limitations to the extent to which
these can be converted into stitches that will make a good piece of embroidery of
a different size.

The greater the change in size, the less good the final result. In practice the limit
is a reduction to half the original size or an increase to twice the original size.
You can see that this still gives you a lot of scope for adjusting the size of a
design to fit your purposes.

Minimum and Maximum Stitch Length

The stitch length depends on frame movements. There are limitations to the
maximum and minimum frame movements the embroidery machine can
make and hence to the maximum and minimum stitch length. The maximum
stitch length depends on the angle of the stitch.

Jumps are frame movements without needle penetrations. When the stitch
length is expanded beyond the maximum stitch length the stitch is divided into
equal length jumps equal to or shorter than the specified jump length Where
there are jumps between needle penetrations the stitch is shown as a dotted
line. Maximum stitch length and jump length can be set by choosing “Stitch
Lengths” from the Function menu.

Maximum stitch length is measured along the X and Y axes not the distance
between needle penetration points.

Stitches shorter than minimum stitch length are automatically removed from
your design.

Click in the Use as Default box to insert a cross if you want the values you are
using to be used for all new designs. Click on “Reset” to return to the initial,
factory set values.
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Scaling The different stitch types

You will notice that your designs are made up of three types of stitching:

• manual for lines and outlines and to travel around your design;
• satin stitch for narrow areas e.g. lettering;
• fill stitch for larger and irregular shapes. The shape is filled with

parallel rows of stitching.

For more details of the different stitch types see chapter 8.

These different types of stitches are handled differently when resizing.

• Manual: the number of manual stitches remains the same but the
length of the stitches is changed. If you enlarge a pattern which has
small curve outlines stitched with manual, you may not have enough
stitches to follow the resized cun’e.

• Satin: stitches are decreased or increased in length when scaled but the
spacing between stitches remains the same. The number of stitches,
therefore, is reduced or increased to fit the new size. When satin stitch
is increased in length the spacing may not be appropriate. Make sure
that the enlarged satin stitches are no longer than 2 - 2.5cm otherwise
the stitches may gape and not cover the fabric adequately.

• Fill: the number of fill stitches is changed to fit the newly sized shape.

Manual stitch
example

•1

Enough stitches Same stitches enlarged. Now, not
to follow a curve enough stitches to follow a curve.

[
Holes

One problem that arises in increasing the size of a piece of embroidery is that
gaps also increase in size. What might be a quite acceptable gap in the original
may not stay so when the design is resized.

There are also problems in decreasing the size of the embroidery. There may be
gaps or holes that you want in the design and that may become too small. [

[
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6

Change Existing Designs

You can change designs in various ways.

• The simplest change is to change thread colours. You can add

or delete colour changes.

• You can combine two or more designs into one design using

Paste From.

• Parts of a design can be rearranged using Move, Cut, Copy,

Paste, Rotate and Mirror; and

• You can delete and move individual stitches and insert

manual stitches.

Change the Colours of a Design

Change the Dispoyed Colours

The displayed thread colours can be changed. You may want to display the

actual colours you intend to sew the design in to check the appearance or you

may want to display the design in bright, highly contrasting colours so the

design can be seen most clearly.

Choose “Thread Colours” from the Function menu. At the top of the dialog bo

which will be displayed are the colours that will be used to represent each oi

fourteen threads. Some or all of these threads have been used in the design. To
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find out what threads have been used look at the colours. If a thread has been

used the stitches in the design will be displayed in the colour shown ror that

thread. There may be more than one thread of the same colour.

At the bottom of the box are sixteen colours that can be used for the threads.

Most of these colours can be changed to change your range of choice.

________ _________ _________ ________ _________ _________

_________ _________ _________ _________ _________ _________ _________

_____________
_____________ _____________

___________________

I
To alter the colour of a thread, click on the circle for that thread number so that

it becomes filled. The colour used for that thread number in the colours at the

bottom of the dialog box will be bordered.

To change to a different colour from the range of colours offered at the bottom

of the dialog box, click on the colour you want to use. The colour shown for the

thread will change to the new colour.

To change to the factory set colours click on ‘Reset”.

Click ‘OK” when you have finished changing colours.

When you return to the design the displayed colours will be those set for the

threads used.

Mix a New Colour

If you would like to mix a new colour, click on the “Mix...” button. (Some

colours cannot be mixed. If the bordered colour is one of these the “Mix...”

button will be greyed and the label shifted to the right hand side of the button.)

A dialog box will be displayed showing the thread number and the thread

description and the colour you have selected. You can modify this colour by

using the boxes below it to alter its composition. Two colour mixing methods

are offered. You can select either HLS (Hue, Lightness, Saturation) or RGB (Red,

Green, Blue).

Thread Ealours

Thread Nunber

01 02

08 09

____

----I-—

Q3 44 Q5
1

i

__________ __________

Qia 011 Qiz

h-

_____

Q6 Q7
- -—

013 Q14

Co 1 or

____ ____ ____

_J

Mix...

LZt I
I ox

Cancel
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The HLS system.

The HLS System works on the Albert H. Munsell Theory of Colour.

Hue is the advancement of colour increased by degrees. It is associated with a

particular colour from the spectrum for example blue, red and yellow. The

range for hue is from 0 to 360 degrees.

HUE (H)

BLUE

MAGENTA CYAN

RED 120 2401
GREEN

YELLOW

Lightness is how bright or dim a colour appears. The range for lightness is from

0 to 100 percent. Zero is equal to black and one hundred is equal to white. At

lightness 0% or 100%, saturation and hue are irrelevant.

no’
J /0

LIGHTNESS (L)

7

(ñO/
.J’_, /0

SATURATION (S)

The most colourful: L=50%, S=100%

Saturation specifies how vivid a colour is. A saturated colour is very intense,

while a less saturated colour appears greyed or muted. You specify saturation a

a percentage in the range 0 through 100. A saturation of 0% is simply a shade of

grey, while a saturation of 100% gives the most intense possible colour having

that hue and lightness.

SATURATION (S)
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The RGB system

The RGB system, also called the additive colour system defines colours as

mixtures of the three additive colour primaries red, green and blue. You

specify colours in the range 0 through 100.

For example, you can define various shades of yellow by mixing equal amounts
of red and green with a smaller amount of (or no) blue. A yellow with the
proportions 90,90, 0. is much brighter than a 30, 30, 0 yellow, while a 100, 100, 20
yellow is a still brighter washed-out light yellow.

You control the overall brightness of the colour with the brightness of the
primaries you use.

Adding equal amounts of the three primaries results in a shade of grey. For
example 33, 33, 33 is a dark grey, while 67, 67, 67 is light grey. Black is 0, 0, 0 and

white is 100, 100, 100.

I
GREEN

BLUE

CYAN
(0,100,100)

I

(0,0,1(

BLACK
(0,0,0)

WHITE

“I

‘YELLOW
- (100,100,0)RED

(100,0,0)
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You can visualize the RGB system as a cube. The three axes are the three

primaries while the origin is black. Each colour is a point within the colour

cube.

When you are happy with the colour you have mixed click on ‘OK’.

Select colours for each of the thread numbers you will be using. The colours are

for the screen display only and have nothing to do with the colours of the fina

stitching. You should choose colours that can be easily seen and which will

show up against each other on the screen.

Change the Embroidery Colours

The colours of the display do not affect the colours of the final embroidery.

When you sew the embroidery you can use any threads you wish. However,

you need to have colour changes to stop the embroidery machine so that you

can change threads. You may also wish to remove colour changes preventing

the embroidery machine from stopping if you do not wish to change threads.

Go To the Desired Stitch

First you must move the current needle position to the stitch where you want

the thread colour to change. To go to” the stitch you want, choose “Go To”

from the Modify menu. Click in the stitch position with the mouse using the

right mouse button to search backwards through the design and the left mouse

button to search forward through the design.

The current needle position is indicated by a white cross. Stitches before the

current needle position are displayed as solid lines in the chosen thread colours,

indicating that they have been stitched. Stitches after the the current needle

position are displayed as stitch points only indicating that they have not been

stitched yet.

If pointing does not place you at the exact stitch you want, you can travel

through the design using the arrow keys. The left and right arrows move you

through the design back and forward I stitch. The up and down arrows move
you through the design back and forward 10 stitches.

If you want to go to the stitch where a colour change has been inserted, for

example to delete a colour change, you can travel from one colour change tc

another by choosing Colour or Colourw

You can Go To the start or end of the design by choosing “Go to Start” or “Go to

End”.If you prefer you can press the Home key for Go to Start and the End key

for Go to End.
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Insert Colour Change

Thread Nu,iber

___ ___ ___ ___

iE

Q1 Q2 03 4 Q5 Q6 07

_______ _______

[.

_______
_______

08 09 016 Cii 012 Q13 014

ox retup... Cancel ]

To insert a colour change choose ‘Colour Change” from the Function menu.

A dialog box will be displayed showing fourteen colours for the screen display.
Click on the number for the desired colour.

If you want to change the colours offered you can access the thread colours
dialog box by clicking on the Setup button at the bottom of the dialog box. The
thread colours dialog box is used as described at the start of this chapter.

When the colours are set up as you wish and you have selected the colour you
want, click on “OK”.

The colour will be displayed up to the next colour change. If you want to
re-colour a section of the embroidery it may be necessary for you to insert two
colour changes one at the beginning and another at the end of the section.

Remove Colour Change

First you need to go to the stitch where the colour change was input. Use

Colour and Colour to find the correct stitch. The status line will show
“Colour Change”. Choose “Clear” from the Function menu.

Go to The End of The Design

To finish, return to the end of the design. Choose “Go To End” from the Modify
menu.

You can also move to the start of the design when you need to by choosing “Go
To Start”.

Using Go To to Explore The Design

Investigate the way a design will be stitched by using Go To. Go To Start and the
design will be displayed as just needle penetration points, then travel to the end

of the design using Colour or the arrow keys to move by stitches. The
stitching will be displayed a section at a time allowing you to see how it was
input, what underlays were used, how the colours were sequenced. This is a
powerful learning tool if you are going to create your own designs using CS-Il.
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7

Combine Designs

As you get further into working with your designs and more adventurous you

can use the techniques described in this chapter.

• view your design in greater detail,

• measuring the dimensions of your design,

• combining two designs,

• manipulating parts of your design.

Viewing Your Design

Zoom

As well as viewing your designs as Show All and 1:1 scale as described in
chapter 3 you can zoom in to view chosen stitches in an enlarged scale. This

allows you to see the stitches in greater detail.

o Choose “Zoom” from the Display menu.

@ Click at a corner of the area you want to enlarge.

A pointer will be displayed. Moving the pointer will reveal a rectangle with

your first selected point fixed in one corner and the pointer at the diagonally

opposite corner.
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Move the pointer until the part of the design you want to see is framed then

click again.

The framed part of the design will be enlarged to fill the screen.

Pan

This command allows you to choose the part of the design centred on the

screen. It allows you to change the display to show parts of the design which

were off the screen.

0 Choose ttPantt from the Display menu. (
A box will be displayed showing an outline indicating where the screen will

be positioned. You can move the outline by moving the pointer. The

pointer position is the point which will be the centre of the new screen

display.

@ Click the mouse when the outline is positioned as you require and the

pointer is at the point you want to be the centre of the screen display.

[
Full Screen

This command enlarges the dplav to fit the full screen without the menu bar [
and status line. This allows you to view the full design at the largest possible

scale by selecting Show All first then Full Screen.

This display mode is also useful if you wish to print a copy of your design.

Display the design as you want to print it then choose Full Screen to display the

design without the surrounds then press Print Screen. [
Press any key or click on a mouse button to return to the normal screen display.

Measure

You can measure between points on your design. [
Choose “Measure” from the Display menu. Click on the first point then move

the pointer to the second point. A line will be displayed on the screen and its

dimensions will be shown in the prompt line in the bottom left hand corner of

the screen. e.g. X:44mm Y:213mm A[ngle]: 27 [degrees] L[engthl:49.3mm.

You can click on another starting point to measure another line or press <ESC>

to end.
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Combine Two Different Designs

“Paste From...” allows you to paste the entire contents of another design into the

design you are working on. The pasted stitches will be placed at the end of the

current design.

Choose “Paste From...” from the Edit menu.

A file listing will be presented similar to the one used for “Open’. Select a

design and click “OK”.

The new design will be selected and an extents box will be displayed ready for

you to move the stitches in the same way as for “Move”. If you want the stitches

to stay in the original pasted position press <ESC>.

If you want to reverse the Paste, choose “Undo”.

Paste From... does not use the clipboard (see below).

Transform Selected Parts of a Design

The following commands give you the means to work with parts of your

design, to rearrange and rotate them.

Select Parts of a Design

You have already seen in chapter 6 how to select the whole design for scale.

Now we will look at how to select part of the design so we can carry out other

transformations.

o Go To the first stitch of the section of the stitching you want to select for

changing.

See chapter 6 if you are not sure how to Go To.

@ Choose “Select” from the Modify menu to turn the select function on.

The menu item will show a tick to indicate that you are selecting stitches.

€ Go To the last stitch you want to change.

The stitches selected will be displayed in black.

o Choose “Select” from the Modify menu to turn off the select function.

The tick will be removed from the menu item.

You will now be ready to carry out various transformations as described below.

After you have finished transforming choose “Deselect All” from the Modify

menu then go to the end of the design and redraw the screen. This is necessary
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